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[bookmark: _Toc183696784]Tutorial Microsoft Word: Mengenal Microsoft Office
Untuk membuka aplikasi Microsoft Word, kita bisa mengakses menu Start pada laptop. Ketikkan "Word" di kolom pencarian, dan aplikasi dengan nama "Word" akan muncul. Jika aplikasi tidak tersedia, kita perlu menginstal Microsoft Office terlebih dahulu.
[image: ]
Gambar: Membuka Microsoft Word
[bookmark: _Toc183696785]Tutorial Microsoft Word: Memulai Dokumen Baru
Setelah membuka Microsoft Word, untuk memulai proyek, klik tombol Blank Document. Dengan mengklik tombol tersebut, halaman kerja Microsoft Word akan terbuka. Di sini, kita dapat melihat berbagai menu seperti Home, Insert, Draw, Design, dan lainnya. 
[image: ][image: ]
Gambar: Membuka Blank Document
[bookmark: _Toc183696786]Tutorial Microsoft Word: Fitur-Fitur di Microsoft Word
Setiap menu memiliki fitur-fitur yang dapat kita gunakan. Sejak Office 2007, kita dapat langsung mengklik ikon-ikon fitur untuk menggunakan layanan dari Microsoft Word.
[image: ]
Gambar: Menu-menu Microsoft Word 
Di bagian bawah menu, kita dapat melihat lembar kerja yang berwarna putih. Untuk mengisi konten, cukup klik di halaman putih tersebut dan ketik menggunakan keyboard. Contohnya, "Penulis makan nasi."
[image: ]
Gambar: Mengisi Konten
Di sebelah kanan bawah, terdapat fitur Zoom In dan Zoom Out yang berfungsi untuk memperbesar atau memperkecil tampilan layar. 
Sementara itu, di sebelah kiri, terdapat informasi mengenai jumlah halaman dan posisi kita saat ini. 
Misal, jika kita menekan Enter hingga mencapai halaman kedua, akan muncul keterangan "Page 2 of 2," yang berarti kita berada di halaman kedua dari dua halaman. 
Jika kita kembali ke halaman pertama, akan muncul "Page 1 of 2," dan jumlah kata dalam dokumen kita juga akan ditampilkan, misal "3 kata: Penulis makan nasi."
[image: ]
Gambar: Membuka Microsoft Word
Demikian pengantar dari penulis mengenai Microsoft Word. Kita akan mempelajari banyak hal menarik dalam kelas ini. Sampai jumpa di materi berikutnya!
[bookmark: _Toc182264308][bookmark: _Toc183696787]Tutorial Microsoft Word: Page Setup
Pada materi kali ini, kita akan mempelajari Page Setup, yaitu pengaturan awal yang perlu kita lakukan sebelum mulai proyek dengan Microsoft Word. 
Langkah pertama adalah mengatur satuan ukuran dari inci ke sentimeter. Untuk melakukannya, ikuti langkah-langkah berikut:
Klik menu File di bagian atas. Pilih Options.
[image: ]
Gambar: Menu Options
Di jendela yang muncul, masuk ke submenu Advanced.
[image: ]
Gambar: Submenu Advanced
Gulir ke bawah hingga menemukan bagian Show measurement in unit of. Pastikan pilihan ini diatur ke cm. Lalu klik OK untuk menyimpan pengaturan.
Setelah mengatur satuan ukuran, kita akan melanjutkan ke pengaturan margin. Margin adalah batas tepi pada dokumen yang membantu kita dalam penataan teks. Untuk mengatur margin:
Klik menu Layout. Lalu pilih tombol Margins.
[image: ]
Gambar: Menu Layout -> Margin
Di sini, Kita akan melihat beberapa pilihan margin, seperti Normal dan Narrow. Jika ingin mengatur margin secara kustom, pilih Custom Margins.
[image: ]
Gambar: Custom Margins
Kita dapat mengatur margin atas, kiri, bawah, dan kanan sesuai kebutuhan. Misal, atur margin atas menjadi 4 cm, kiri 4 cm, bawah 3 cm, dan kanan 3 cm.
[image: ]
Gambar: Hasil Custom Margin
Selanjutnya, kita akan mengatur orientasi halaman. Di menu Layout, Kita akan menemukan opsi Orientation. Terdapat dua pilihan:
· Portrait (vertikal)
· Landscape (horizontal)
Pilih orientasi yang sesuai dengan kebutuhan dokumen Kita.
[image: ]
Gambar: Menu Layout -> Orientation
Kita juga dapat mengatur ukuran halaman. Di menu Layout, pilih Size. Di sini, Kita akan menemukan berbagai pilihan ukuran kertas, seperti A4, Legal, dan A3. Ukuran default adalah A4. 
[image: ]
Gambar: Menu Layout -> Size
Hal lain yang sering digunakan dalam pengaturan halaman adalah kolom. Di menu Layout, Kita dapat mengatur jumlah kolom yang diinginkan, misal menjadi 2 atau 3 kolom, sesuai dengan kebutuhan dokumen.
[image: ]
Gambar: Menu Layout -> Column
Demikianlah penjelasan mengenai Page Setup pada Microsoft Word. Silakan praktekkan langkah-langkah di atas untuk mengatur dokumen Kita dengan lebih baik. 
[bookmark: _Toc182265295][bookmark: _Toc183696788]Tutorial Microsoft Word: Teks
Pada materi ini, kita akan mengenal teks dalam Microsoft Word. Mari kita mulai dengan memahami beberapa istilah yang penting dalam Microsoft Word. 
Ketika penulis mengetik huruf "A", huruf tersebut disebut karakter. Kumpulan huruf membentuk sebuah kata (word), dan kumpulan kata dapat membentuk sebuah kalimat (sentence). Jika kita memiliki minimal dua kalimat yang tersusun, itu dinamakan paragraf.
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Gambar: Istilah Penting dalam Microsoft Word
[bookmark: _Toc182265296][bookmark: _Toc183696789]Tutorial Microsoft Word: Pengaturan Teks
Kita dapat mengatur pengaturan teks pada bagian Home. Contohnya, kita bisa mengatur font size. Pertama, blok kata yang ingin diubah, misal "penulis". Kemudian, pilih ukuran font di bagian ini, misal kita ubah menjadi ukuran 20. 
[image: ][image: ]
Gambar: Mengatur Font Size
Selain itu, ada istilah font yang merujuk pada jenis huruf. Jika kita blok kata atau kalimat yang ingin dipilih, misal "Penulis makan nasi", kita bisa mengubah font dari Calibri menjadi Times New Roman, sehingga gaya tulisan berubah.
[image: ][image: ]
Gambar: Mengubah Jenis Font
Untuk mengubah ukuran font, kita juga bisa menggunakan tombol dengan huruf "A" di sini, yang memiliki simbol A besar dan A kecil. Misal, kita bisa memperbesar atau memperkecil ukuran font.
[image: ]
Gambar: Mengubah Ukuran Font dengan Tombol A
Selanjutnya, di bagian Home, terdapat beberapa pengaturan lain yang bisa kita gunakan. Ada opsi Bold untuk menebalkan tulisan, Italic untuk memiringkan tulisan, dan Underline untuk memberi garis bawah pada tulisan. 
[image: ]
Gambar: Pengaturan Bold Italic & Underline
Contohnya, jika kita memilih Bold pada tulisan "penulis" ,  maka tulisan "penulis" akan menjadi tebal. Jika penulis memilih Italic pada tulisan "makan", maka tulisan "makan" akan miring, dan jika penulis memilih Underline pada tulisan "nasi", maka tulisan "nasi" akan bergaris bawah. 
[image: ]
Gambar: Penerapan Bold Italic & Underline
Kita juga bisa menggabungkan semua pengaturan ini, misal dengan membuat tulisan "penulis" menjadi Bold, miring, dan bergaris bawah sekaligus.
[image: ]
Gambar: Mengubah Tulisan Bold Italic & Underline Sekaligus
Pada halaman Home, kita juga dapat mewarnai tulisan. Misal, penulis ingin mengubah warna tulisan menjadi merah, atau bisa juga memilih warna lain seperti hijau, biru, dan sebagainya. Sebagai contoh, penulis pilih warna ungu.
[image: ]
Gambar: Mengubah Warna Teks
[bookmark: _Toc182265297][bookmark: _Toc183696790]Tutorial Microsoft Word: Perataan Teks
Di bagian Home, terdapat fitur perataan yang sering kita gunakan. Pertama, penulis telah membuat empat paragraf untuk menunjukkan perataan.
[image: ]
Gambar: Contoh Empat Paragraf
Untuk paragraf pertama, kita bisa mengatur perataan menjadi Align Left, sehingga perataan akan berada di sebelah kiri.
[image: ]
Gambar: Mengatur Align Left
Untuk paragraf kedua, kita blok dan ubah perataan menjadi Center, sehingga hasilnya akan berada di tengah.
[image: ]
Gambar: Mengatur Align Center

Untuk paragraf ketiga, kita blok dan pilih Align Right, sehingga paragraf akan berada di sebelah kanan.
[image: ]
Gambar: Mengatur Align Right
Terakhir, ada opsi Justify, yang jika kita pilih, akan membuat teks rata di kedua sisi, kanan dan kiri.
[image: ]
Gambar: Mengatur Align Justify
Itulah penjelasan mengenai pengaturan teks, termasuk pengaturan font, ukuran, dan perataan dalam Microsoft Word.
[bookmark: _Toc182265910][bookmark: _Toc183696791]Tutorial Microsoft Word: Heading
Pada materi kali ini, kita akan mengenal Heading. Heading sangat diperlukan ketika kita membuat sebuah dokumen yang memerlukan daftar isi, sehingga memudahkan kita saat menyusun daftar isi tersebut.
[bookmark: _Toc182265911][bookmark: _Toc183696792]Tutorial Microsoft Word: Apa itu Heading ?
Heading adalah format yang digunakan untuk judul dalam dokumen. Sebagai contoh, penulis telah membuat sebuah artikel yang terdiri dari judul, konten, dan sub-sub judul. Untuk menggunakan Heading, kita dapat memformat judul dengan cara memblok teks yang ingin dijadikan Heading.
[image: ]
Gambar: Contoh Artikel
[bookmark: _Toc182265912][bookmark: _Toc183696793]Tutorial Microsoft Word: Cara Menggunakan Heading
Memblok Teks: Pertama, blok teks yang ingin Kita format sebagai Heading.
[image: ]
Gambar: Memblok Teks
Menu Home: Masuk ke menu Home. Di sini, Kita akan menemukan bagian Styles.
[image: ]
Gambar: Menu Home -> Styles
Memilih Heading: Pilih Heading yang sesuai. Untuk judul utama, pilih Heading 1. 
[image: ]
Gambar: Mengatur Heading 1
Setelah itu, kita juga akan mengatur bagian submenu sebagai Heading. Blok teks tersebut dan pilih Heading 2 untuk sub judul.
[image: ]
Gambar: Mengatur Heading 2
[bookmark: _Toc182265913][bookmark: _Toc183696794]Tutorial Microsoft Word: Mengatur Format Heading
Jika Kita ingin mengubah warna atau format dari Heading, Kita dapat melakukannya dengan cara berikut:
Klik Kanan: Klik kanan pada Heading yang ingin diubah, lalu pilih Modify.
[image: ]
Gambar: Modify Heading
Pengaturan Format: Di sini, Kita dapat mengatur berbagai format, seperti jenis font, ukuran font, serta menambahkan efek seperti Bold, Italic, atau Underline. 
Misal, Kita dapat mengatur Heading 2 menjadi font Times New Roman, ukuran 12, dengan efek Bold dan warna hitam.
[image: ]
Gambar: Mengatur Format Heading
Setelah mengklik OK, semua Heading 2 yang Kita format akan berubah sesuai pengaturan yang telah Kita buat.
Itulah cara penggunaan Heading pada Microsoft Word. Dengan menggunakan Heading, Kita dapat dengan mudah menyusun dokumen dan membuat daftar isi secara otomatis, yang sangat berguna dalam penulisan dokumen ilmiah, seperti skripsi atau laporan. 
[bookmark: _Toc182266697][bookmark: _Toc183696795]Tutorial Microsoft Word: Membuat Daftar Isi
Pada bab kali ini, kita akan mempelajari cara membuat daftar isi di Microsoft Word. Sebelumnya, kita telah membahas secara singkat tentang penggunaan Heading dalam dokumen. 
Heading ini sangat berguna untuk memudahkan pembuatan daftar isi. Misal, kita memiliki Heading 1, Heading 2, dan seterusnya. Sekarang, mari kita buat daftar isi di bagian bawah dokumen kita.
[bookmark: _Toc182266698][bookmark: _Toc183696796]Tutorial Microsoft Word: Langkah-Langkah Membuat Daftar Isi
Membuat Halaman Baru: Pertama, kita perlu membuat halaman baru untuk daftar isi. Caranya, klik Insert, lalu pilih Blank Page. Halaman baru akan muncul di dokumen Kita.
[image: ]
Gambar: Menu Insert -> Black Page
Mengakses Menu References: Setelah halaman baru siap, fokuslah pada menu References. Klik menu ini, dan Kita akan menemukan opsi Table of Contents.
[image: ]
Gambar: Menu References -> Table of Contents
Memilih Gaya Daftar Isi: Di dalam menu Table of Contents, terdapat beberapa pilihan gaya daftar isi. Pilihlah yang paling sesuai dengan kebutuhan Kita, misal pilihan yang paling atas.
[image: ]
Gambar: Memilih Daftar Isi
Mengatur Daftar Isi: Setelah memilih, daftar isi akan otomatis terisi berdasarkan Heading yang telah Kita buat. Heading 1 akan berada di paling kiri, dan Heading 2 akan memiliki indentasi lebih ke dalam.
[image: ]
Gambar: Istilah Penting dalam Microsoft Word
Mengupdate Daftar Isi:Jika Kita melakukan perubahan pada dokumen, seperti memindahkan Heading ke halaman lain, Kita perlu mengupdate daftar isi agar nomor halaman sesuai.
[image: ]
Gambar: Memindahkan Heading ke Halaman Lain
Cara Mengupdate: Klik kanan pada daftar isi, lalu pilih Update Table.
[image: ]
Gambar: Update Table
Pilih Update Entire Table untuk memperbarui seluruh konten dan nomor halaman.
[image: ]
Gambar: Update Entire Table 
Klik OK, dan daftar isi Kita akan diperbarui sesuai perubahan yang telah dilakukan.
[image: ]
Gambar: Hasil Update Entire Table 
Membuat daftar isi di Microsoft Word sangatlah mudah dengan menggunakan menu References dan Table of Contents. 
[bookmark: _Toc182268030][bookmark: _Toc183696797]Tutorial Microsoft Word: Indent dan Ruler
Pada materi kali ini, kita akan mempelajari tentang indent dan ruler di Microsoft Word. Apa itu Indent dan Ruler?
[image: ]
Gambar: Menu Indent
· Indent adalah ruang kosong yang digunakan untuk menjorokkan teks dari batas kiri atau kanan paragraf.
· Ruler adalah penggaris yang membantu kita mengatur posisi teks dan margin dalam dokumen.



[bookmark: _Toc182268031][bookmark: _Toc183696798]Tutorial Microsoft Word: Menggunakan Indent
Di dalam dokumen kita, terdapat paragraf yang bisa kita atur. Pertama, kita akan masuk ke tab Home. Di sini, kita akan menemukan tombol untuk Decrease Indent dan Increase Indent.
[image: ][image: ]
Gambar: Menu Indent
Sebagai contoh, penulis akan menggunakan Increase Indent untuk memberikan ruang kosong pada paragraf pertama. Arahkan kursor ke paragraf tersebut, lalu klik tombol Increase Indent. 
[image: ][image: ]
Gambar: Menu Indent
Dengan melakukan ini, akan ada ruang kosong di sebelah kiri paragraf. Jika ingin menambah ruang lagi, cukup klik tombol tersebut sekali lagi. Kita juga bisa menggunakan Decrease Indent untuk mengurangi ruang yang telah ditambahkan.
[bookmark: _Toc182268032][bookmark: _Toc183696799]Tutorial Microsoft Word: Menggunakan Ruler
Selanjutnya, kita akan membahas tentang Ruler. Jika Kita tidak melihat penggaris di atas atau di samping dokumen, Kita bisa mengaktifkannya melalui menu View dan centang opsi Ruler.
[image: ]
Gambar: Menu View -> Ruler
Jika penggaris yang muncul masih menggunakan sistem inci, Kita bisa mengubahnya ke sentimeter. Caranya, masuk ke menu File, pilih Options, lalu pilih Advanced. 
[image: ]
Gambar: Menu View -> Ruler
Di bagian Measurement units, pilih Centimeters dan klik OK. Sekarang, penggaris akan ditampilkan dalam sentimeter.
[bookmark: _Toc182268033][bookmark: _Toc183696800]Tutorial Microsoft Word: Mengatur Margin dengan Ruler
Dengan menggunakan ruler, kita bisa mengatur margin dokumen. Sebelumnya, kita telah mengatur margin melalui menu Layout. Namun, kita juga bisa melakukannya langsung dari ruler.
[image: ]
Gambar: Mengatur Margin Lewat Menu Layout
Di sisi kiri ruler, Kita akan melihat pengatur untuk margin atas. Kita bisa mengubahnya dengan menggeser pengatur tersebut. 
[image: ]
Gambar: Mengatur Margin Atas dengan Sisi Kiri Ruler
Misal, jika Kita ingin memperpanjang margin, cukup geser pengatur ke arah yang diinginkan. Jika Kita ingin mengatur margin kiri, Kita juga bisa melakukannya dengan cara yang sama.
[bookmark: _Toc182268034][bookmark: _Toc183696801]Tutorial Microsoft Word: Mengatur Indensitas Baris Pertama
Selain itu, kita juga bisa mengatur First Line Indent menggunakan ruler. Di bagian atas ruler, terdapat panah yang mengarah ke bawah. Ini berfungsi untuk mengatur indentasi pada baris pertama paragraf. 
[image: ]
Gambar: First Line Indent
Misal, jika Kita ingin mengatur First Line Indent menjadi 3 cm, geser panah tersebut ke angka 3 cm. Dengan demikian, akan ada ruang kosong di awal paragraf.
[image: ]
Gambar: Mengatur First Line Indent Menjadi 3cm
Kita juga bisa mengatur Left Indent di bagian bawah ruler. Misal, jika Kita ingin mengatur Left Indent menjadi 2 cm, geser pengatur tersebut ke angka 2 cm. 
[image: ]
Gambar: Mengatur Left Indent Menjadi 2cm
Hasilnya, indentasi akan terlihat seperti ini: 2 cm untuk left indent dan 3 cm untuk first line indent.
Itulah penjelasan mengenai indent dan ruler di Microsoft Word. Dengan memahami cara menggunakan kedua fitur ini, Kita dapat membuat dokumen yang lebih terstruktur dan rapi. 
[bookmark: _Toc183696802]Tutorial Microsoft Word: Bullets dan Numbering
Pada materi kali ini, kita akan mempelajari tentang Bullets dan Numbering di Microsoft Word.
[bookmark: _Toc183696803]Tutorial Microsoft Word: Apa Itu Bullet?
Bullet adalah sebuah daftar tidak terurut (unordered list) yang digunakan untuk menkitai poin-poin dalam teks. Jika kita masuk ke menu Home, kita akan menemukan ikon yang menampilkan poin-poin. Inilah yang disebut dengan Bullet. 
[image: ]
Gambar: Contoh Artikel
Sebagai contoh, penulis telah membuat sebuah paragraf yang berisi daftar vitamin seperti vitamin C, A, Kalium, dan serat. 
[image: ]
Gambar: Contoh Daftar Vitamin
Untuk mengubahnya menjadi daftar dengan Bullet, kita perlu memisahkan setiap item ke baris baru, misalnya:
· Vitamin A
· Vitamin C
· Kalium
· Serat
Setelah itu, kita blok teks tersebut dan klik ikon Bullet. Maka, teks akan berubah menjadi daftar dengan Bullet. 
[image: ]
Gambar: Menerapkan Daftar Bullet
Jika kita ingin mengubah gaya Bullet, kita bisa klik tombol panah di samping ikon Bullet dan memilih berbagai macam gaya Bullet yang tersedia, termasuk yang berwarna.
[bookmark: _Toc183696804]Tutorial Microsoft Word: Apa Itu Numbering?
Numbering adalah fitur penomoran yang digunakan untuk membuat daftar terurut (ordered list). Misalnya, kita memiliki daftar vitamin B seperti folat, riboflavin, dan niacin. Sama seperti sebelumnya, kita perlu memisahkan setiap item ke baris baru:
1. Folat
2. Riboflavin
3. Niacin
Kemudian, kita blok teks tersebut dan klik ikon Numbering yang berada di sebelah kanan ikon Bullet. Numbering akan mengubah teks menjadi daftar bernomor. 
[image: ][image: ]
Gambar: Mengatur Penomoran dengan Numbering
Kita juga bisa mengubah gaya penomoran dengan mengklik tombol panah di samping ikon Numbering, dan memilih format yang diinginkan, seperti angka, huruf, atau angka Romawi.


Ini berguna untuk menyesuaikan tampilan daftar agar lebih rapi. Dengan memahami cara menggunakan Bullets dan Numbering, kita dapat membuat dokumen yang lebih terstruktur dan mudah dibaca. 
[bookmark: _Toc182269234][bookmark: _Toc183696805]Tutorial Microsoft Word: Spacing
Pada bab kali ini, kita akan membahas tentang spacing atau spasi. Namun, perlu kita ketahui bahwa spasi yang dimaksud di sini bukanlah spasi antar huruf, melainkan spasi antar baris. Jadi, spacing adalah jarak atau spasi yang terdapat di antara baris-baris teks.
[image: ]
Gambar: Menu Line & Paragraf Spacing
[bookmark: _Toc182269235][bookmark: _Toc183696806]Tutorial Microsoft Word: Langkah-Langkah Mengatur Spacing
Berikut adalah langkah-langkah yang perlu kita lakukan untuk mengatur spacing:
Memilih Teks: Pertama-tama, kita perlu memblok atau memilih bagian teks yang ingin kita atur spacing-nya. Misal, jika kita ingin mengubah spacing untuk seluruh dokumen, kita bisa menggunakan shortcut Ctrl + A untuk memblok semua teks.
[image: ]
Gambar: Memblok Semua Teks
Mengakses Menu Spacing: Setelah teks terblok, kita akan melihat opsi spacing di bagian Home. Di sini, terdapat kategori Paragraf dengan ikon Line and Paragraph Spacing. Kita bisa mengklik ikon tersebut untuk melihat pilihan spacing yang tersedia.
[image: ]
Gambar: Mengakses Menu Spacing
Memilih Jenis Spacing: Di menu yang muncul, kita bisa memilih jenis spacing yang diinginkan, seperti 1, 1.5, 2, dan seterusnya. Misal, jika kita ingin mengatur spacing menjadi 1.5, kita tinggal memilih opsi tersebut. Jika kita memilih spacing 1, maka teks akan terlihat lebih rapat.
[image: ]
Gambar: Menagtur Jenis Spacing Menjadi 1.5
[bookmark: _Toc182269236][bookmark: _Toc183696807]Tutorial Microsoft Word: Mengatur Spacing Sebelum & Sesudah Paragraf
Selanjutnya, kita juga bisa mengatur before dan after space pada paragraf. Di bagian pengaturan spacing, terdapat opsi untuk remove space. Jika kita memilih opsi ini, maka tidak akan ada jarak antara paragraf, baik sebelum maupun sesudahnya.
[image: ]
Gambar: Mengakses Meni Before & After Space
Sebagai contoh, jika kita menggunakan spacing 1 dan kemudian menambahkan add space before, akan ada jarak tambahan sebelum setiap paragraf. Sebaliknya, jika kita memilih remove, maka paragraf akan terlihat lebih rapat.
[image: ]
Gambar: Penerapan Add Space Before
[bookmark: _Toc182269237][bookmark: _Toc183696808]Tutorial Microsoft Word: Opsi Lanjutan untuk Mengatur Spacing 
Kita juga bisa mengatur lebih lanjut melalui tombol yang sama dengan mengklik Line Spacing Options. Di sini, kita dapat menentukan jarak antar paragraf. 
[image: ]
Gambar: Mengakses Line Spacing Options
Terdapat beberapa pilihan seperti single, double, dan lainnya. Misal, kita bisa mengatur spacing menjadi 3 pt untuk jarak sebelum dan sesudah paragraf. Setelah mengatur, jangan lupa untuk mengklik OK agar perubahan diterapkan.
[image: ]
Gambar: Mengatur Line Spacing Options
Dengan mengikuti langkah-langkah di atas, kita dapat mengatur spacing di Microsoft Word dengan lebih rapi dan teratur. Semoga materi ini bermanfaat bagi kita dalam membuat dokumen yang lebih profesional dan enak dibaca. 
[bookmark: _Toc182269913][bookmark: _Toc183696809]Tutorial Microsoft Word: Tabel
Pada materi kali ini, kita akan mempelajari materi baru, yaitu tabel di Microsoft Word. 
[bookmark: _Toc182269914][bookmark: _Toc183696810]Tutorial Microsoft Word: Memasukan Tabel
Untuk memasukkan tabel, langkahnya sangat mudah. Pertama, buka menu Insert. Di sana, Kita akan menemukan fitur Table.
[image: ]
Gambar: Menu Insert -> Table
Jika kita klik di sini, kita bisa menggunakan opsi Insert Table yang instan. Kita hanya perlu mengarahkan pointer mouse ke jumlah baris dan kolom yang ingin dibuat. 
Misal, jika kita ingin membuat tabel dengan 3 kolom dan 6 baris, arahkan pointer ke 3 kolom dan 6 baris, lalu klik. Tabel dengan 3 kolom dan 6 baris pun akan muncul.
[image: ]
Gambar: Membuat Tabel 3 Kolom 6 Baris
[bookmark: _Toc182269915][bookmark: _Toc183696811]Tutorial Microsoft Word: Mengisi Konten Tabel
Untuk mengisi konten tabel, cukup klik pada sel yang ingin diisi. Misal, pada baris pertama kolom pertama, kita bisa mengetikkan nomor. 
Di kolom kedua baris pertama, kita bisa menuliskan nama makanan, dan di kolom ketiga baris pertama, kita bisa menambahkan manfaat. 
Setelah itu, tabel akan terisi dengan informasi yang kita masukkan. Jika kita mengklik di luar tabel, pengaturan akan hilang, tetapi tabel tetap ada.
[image: ]
Gambar: Mengisi Kolom Tabel
[bookmark: _Toc182269916][bookmark: _Toc183696812]Tutorial Microsoft Word: Mengatur Desain Tabel
Ketika kita kembali ke tabel, akan muncul menu baru yaitu Table Design. Di sini, kita bisa memilih tema untuk tabel, seperti warna hijau dan lain-lain. 
[image: ]
Gambar: Menu Table Design -> Plain Tables
Jika kita ingin agar header tabel selalu muncul di halaman baru, kita bisa memilih baris header, lalu pergi ke menu Layout dan klik Repeat Header Row. Ini berguna jika tabel kita memiliki banyak baris, sehingga header tetap terlihat di setiap halaman.
[image: ]
Gambar: Menu Layout -> Repeat Header Row
[bookmark: _Toc182269917][bookmark: _Toc183696813]Tutorial Microsoft Word: Membuat Tabel Baru
Jika kita ingin membuat tabel baru, kita bisa kembali ke menu Insert Table. 
Misal, jika kita ingin membuat tabel dengan 30 baris dan 4 kolom, kita bisa memasukkan jumlah kolom dan baris yang diinginkan. 
Setelah mengklik OK, tabel baru dengan jumlah yang kita tentukan akan terbentuk.
[image: ][image: ]
Gambar: Membua Tabel Baru dengan Insert Table
[bookmark: _Toc182269918][bookmark: _Toc183696814]Tutorial Microsoft Word: Mengatur Border Tabel
Pada bagian Table Design, kita juga bisa mengatur border tabel. Pilih semua kolom, lalu pilih warna border yang diinginkan, misal hitam. 
Kita bisa memilih format border seperti Outside Border, No Border, atau All Border untuk mengatur tampilan tabel sesuai keinginan.
[image: ]
Gambar: Mengatur Border Tabel
[bookmark: _Toc182269919][bookmark: _Toc183696815]Tutorial Microsoft Word: Menggabungkan Sel (Merge Cells)
Di menu Layout, kita juga bisa melakukan merge cells. Merge cells adalah penyatuan beberapa sel menjadi satu. 
Misal, kita bisa menyatukan semua sel di baris pertama kolom pertama dan kedua. 
Setelah memilih sel yang ingin digabung, klik Merge. Hasilnya, sel tersebut akan menyatu dan terlihat lebih besar.
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Gambar: Mengatur Merge Cells
Itu dia penjelasan mengenai cara membuat dan mengatur tabel di Microsoft Word. Silakan eksplorasi lebih lanjut pada bagian Table Design dan Layout untuk menemukan berbagai fitur menarik lainnya. 
[bookmark: _Toc182270813][bookmark: _Toc183696816]Tutorial Microsoft Word: Page Number
Pada materi kali ini, kita akan membahas tentang penomoran halaman atau page number di Microsoft Word. Menambahkan penomoran halaman sangatlah mudah. 
Pertama, buka menu Insert. Di sini, Kita akan menemukan fitur Page Number. Klik pada opsi tersebut, dan Kita akan melihat beberapa pilihan untuk penomoran halaman, baik di bagian atas maupun di bawah halaman.
[image: ]
Gambar: Menu Insert -> Page Number
Sebagai contoh, penulis akan menggunakan penomoran di bawah halaman. Kita dapat memilih berbagai style yang tersedia, baik yang sederhana maupun yang memiliki tambahan desain. Misal, penulis akan memilih style yang bernama "Assign Bar 4".
[image: ]
Gambar: Memilih Style Assign Bar 4
Setelah memilih style, nomor halaman akan muncul secara otomatis. Kita juga akan melihat teks template yang bertuliskan "Page". Mari kita ubah teks ini menjadi "Makalah Karya Penulis" sebagai contoh.
[image: ]
Gambar: Mengubah Teks Template
Untuk kembali fokus pada konten, cukup klik dua kali pada area konten dokumen. Sekarang, Kita akan melihat penomoran halaman yang berurutan, seperti halaman 1, halaman 2, halaman 3, dan seterusnya.
[image: ]
Gambar: Kembali ke Fokus Konten
[bookmark: _Toc182270814][bookmark: _Toc183696817]Tutorial Microsoft Word: Menambahkan Halaman Sampul
Jika Kita ingin menambahkan halaman sampul, Kita bisa membuat Blank Page di awal dokumen. Misal, kita tambahkan cover di sini.
[image: ]
Gambar: Membuat Blank Page untuk Sampul
Namun, jika Kita ingin menghilangkan nomor halaman pada halaman sampul, cukup klik pada Page Number dan pilih opsi Different First Page. Dengan cara ini, nomor halaman tidak akan muncul di halaman pertama.
[image: ]
Gambar: Mengaktifkan Differents First Page pada Sampul
[bookmark: _Toc182270815][bookmark: _Toc183696818]Tutorial Microsoft Word: Mengatur Nomor Halaman
Selanjutnya, kita bisa mengatur nomor halaman agar dimulai dari angka nol. Kembali ke menu Page Number, pilih Format Page Number, dan ubah Start at menjadi nol. 
[image: ]
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Gambar: Mengatur Nomor Halaman Agar Dimulai dari 0
Dengan pengaturan ini, halaman pertama setelah cover akan menjadi halaman 1, sementara halaman cover tidak akan memiliki nomor.
[image: ]
Gambar: Hasil mengatur Nomor Halaman yang Dimulai dari 0
[bookmark: _Toc182270816][bookmark: _Toc183696819]Tutorial Microsoft Word: Mengubah Format Nomor Halaman
Selain itu, Kita juga dapat mengubah format nomor halaman. Misal, jika Kita ingin menggunakan angka Romawi atau huruf, Kita bisa kembali ke menu Header and Footer. 
[image: ]
Gambar: Format Page Number
Klik pada Page Number, lalu pilih Format Page Number. Di sini, Kita dapat memilih format yang diinginkan, seperti angka Romawi atau huruf.
[image: ]
Gambar: Pengaturan Format Page Number
Dengan langkah-langkah di atas, Kita dapat dengan mudah menambahkan dan mengatur penomoran halaman di Microsoft Word. 
[bookmark: _Toc182271121][bookmark: _Toc183696820]Tutorial Microsoft Word: Header dan Footer
Selain menambahkan nomor halaman di bagian bawah dokumen, kita juga bisa mengatur header dan footer. 
Header adalah bagian di atas konten utama, sedangkan footer berada di bawah konten utama, tepat di area margin. 
Berikut adalah cara untuk mengatur header dan footer di Microsoft Word: Masuk ke tab Insert di menu Word. Pilih opsi Header atau Footer sesuai kebutuhan .
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Gambar: Menu Insert -> Header & Footer
Alternatif lainnya, Kita bisa langsung mengklik dua kali pada area header di bagian atas atau footer di bagian bawah dokumen. Ini akan membawa Kita langsung ke mode pengeditan header atau footer.
[image: ]
Gambar: Hasil Klik 2x Pada Bagian Header
Setelah masuk ke mode pengeditan header, Kita akan melihat menu yang memungkinkan Kita memilih berbagai template header yang tersedia.
Misal, Kita bisa memilih template yang menarik seperti "Retos Pack". Setelah memilih, template tersebut akan muncul di dokumen Kita.
[image: ]
Gambar: Memilih Template Header
Isi informasi yang diperlukan, seperti judul dokumen atau tanggal. Misal, Kita bisa mengisi judul dengan "Manfaat Makan Buah-buahan" dan tanggal dengan "26 September 2023".
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Gambar: Mengubah Isi Informasi
Untuk footer, prosesnya serupa dengan header. Namun, jika Kita sudah menambahkan nomor halaman di footer, Kita tidak bisa menambahkan elemen lain di sana karena akan menimpa nomor halaman yang sudah ada.
Dengan mengikuti langkah-langkah di atas, Kita dapat dengan mudah menambahkan dan mengatur header dan footer di dokumen Word Kita. 
[bookmark: _Toc182271427][bookmark: _Toc183696821]Tutorial Microsoft Word: WordArt
Pada materi teks sebelumnya, kita telah mempelajari cara mengatur ukuran dan warna untuk memperindah judul atau konten kita. 
Namun, bagaimana jika kita ingin membuat judul yang lebih menarik daripada sekadar teks biasa atau warna stkitar? Di sinilah WordArt berperan.
WordArt adalah fitur yang memungkinkan kita menambahkan tampilan artistik pada teks yang kita pilih. Untuk menggunakan WordArt, ikuti langkah-langkah berikut:
Pilih Teks: Blok teks yang ingin Kita ubah menjadi WordArt.
[image: ]
Gambar: Blok Teks yang Ingin Diubah

Masuk ke Menu Insert: Di dalam menu Insert, Kita akan menemukan pilihan WordArt. Klik opsi ini untuk melihat berbagai template dan gaya yang tersedia.
[image: ]
Gambar: Pilihan WordArt
Pilih Gaya: Pilih salah satu gaya WordArt yang Kita suka. Setelah memilih, teks yang telah Kita blok akan otomatis berubah sesuai dengan gaya yang dipilih.
[image: ]
Gambar: Penerapan WordArt
Atur Ukuran dan Spacing: Kita dapat menyesuaikan ukuran dan jarak (spacing) teks agar lebih sesuai dan terlihat menarik.
[image: ]
Gambar: Mengatur Ukuran & Spacing WordArt
Dengan menggunakan WordArt, Kita dapat memberikan sentuhan kreatif pada dokumen Kita, menjadikannya lebih menarik dan profesional. 
[bookmark: _Toc182272211][bookmark: _Toc183696822]Tutorial Microsoft Word: Pictures and Shapes
Menambahkan gambar ke dalam dokumen sangat penting untuk membuatnya lebih menarik dan tidak membosankan. 
[bookmark: _Toc182272212][bookmark: _Toc183696823]Tutorial Pictures and Shapes: Menambahkan Gambar
Untuk menambahkan gambar, langkah pertama adalah masuk ke menu Insert. Di sini, Kita akan menemukan opsi Pictures. Klik opsi tersebut, lalu pilih This Device untuk mencari file gambar yang ada di komputer Kita. 
[image: ]
Gambar: Insert Picture
Gambar dapat berupa format JPEG, PNG, atau format lainnya. Pilih gambar yang telah Kita unduh dan simpan di perangkat Kita.
Setelah memilih gambar, Kita dapat memindahkannya dengan cara memotong (cut) dan menempelkannya (paste) di lokasi yang diinginkan dalam dokumen. 
[image: ]
Gambar: Hasil Insert Picture
[bookmark: _Toc182272213][bookmark: _Toc183696824]Tutorial Pictures and Shapes: Mengatur Gambar
Setelah gambar ditambahkan, Kita dapat mengatur tampilannya. Klik pada gambar tersebut, dan menu baru bernama Picture Format akan muncul. 
[image: ]
Gambar: Picture Format -> Correction
Di sini, Kita dapat melakukan beberapa penyesuaian, seperti:
· Correction: Mengatur kecerahan gambar, membuatnya lebih cerah, atau mengubah warnanya menjadi hitam putih.
· Transparency: Mengatur tingkat transparansi gambar.
· Styles: Menambahkan efek seperti bingkai, bayangan, atau mengubah bentuk gambar menjadi bulat.
Jika ukuran gambar terlalu besar (misal lebih dari 5 MB), Kita dapat mengompresnya agar dokumen tidak terlalu berat. Caranya, klik gambar, lalu di menu Picture Format, pilih Compress Pictures. 
[image: ][image: ]
Gambar: Format Picture -> Compress Picture
Kita dapat memilih opsi untuk Print atau Web, kemudian klik OK. Gambar akan terkompres sehingga ukuran file menjadi lebih kecil.
[bookmark: _Toc182272214][bookmark: _Toc183696825]Tutorial Pictures and Shapes: Menambahkan Efek dan Border
Kita juga dapat menambahkan efek pada gambar, seperti Picture Border untuk menambahkan bingkai berwarna, atau Picture Effect untuk menambahkan bayangan, refleksi, dan lain-lain. 
Misal, untuk menambahkan bayangan, pilih efek Shadow dan pilih jenis bayangan yang diinginkan, seperti Outer. Bayangan akan muncul di sekitar gambar.
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Gambar: Picture Format -> Picture Border
[bookmark: _Toc182272215][bookmark: _Toc183696826]Tutorial Pictures and Shapes: Mengatur Posisi Gambar
Jika gambar terlalu kecil, Kita dapat mengatur posisi gambar dengan menggunakan Wrap Text. Pilihan yang tersedia termasuk Inline with Text, Square, Behind Text, dan In Front of Text. 
[image: ]
Gambar: Picture Format -> Warp Text
Untuk gambar yang lebih kecil, pilih Square agar gambar dapat ditempatkan di area kosong dalam dokumen.
[bookmark: _Toc182272216][bookmark: _Toc183696827]Tutorial Pictures and Shapes: Menambahkan Shape
Selain gambar, Kita juga dapat menambahkan Shapes. Kembali ke menu Insert, pilih Shapes untuk melihat berbagai bentuk yang tersedia. Misal, Kita dapat menambahkan bentuk kotak atau bintang. 
[image: ]
Gambar: Insert -> Shapes
Setelah menambahkan bentuk, Kita dapat mengatur warna dan outline-nya melalui menu Shape Format. 
[image: ]
Gambar: Shape Format
Misal, Kita dapat mengubah warna bentuk menjadi kuning dan outline menjadi merah.
[image: ]
Gambar: Mengubah Warna Bentuk
Dengan mengikuti langkah-langkah di atas, Kita dapat membuat dokumen Word yang lebih menarik dan interaktif dengan menggunakan gambar dan bentuk. 
[bookmark: _Toc182272808][bookmark: _Toc183696828]Tutorial Microsoft Word: SmartArt dan Grafik
Pada Microsoft Word, terdapat fitur yang sangat berguna yaitu SmartArt dan grafik. Fitur ini dapat diakses melalui menu Insert. 
SmartArt digunakan untuk membuat diagram dengan berbagai jenis yang dapat dipilih, sehingga memudahkan kita dalam menyajikan informasi secara visual tanpa perlu mendesainnya terlebih dahulu menggunakan aplikasi desain lainnya.
[image: ]
Gambar: Insert SmartArt Graphic
[bookmark: _Toc182272809][bookmark: _Toc183696829]Tutorial Microsoft Word: Menggunakan SmartArt
Memilih SmartArt: Ketika Kita mengklik SmartArt, akan muncul berbagai jenis diagram yang bisa dipilih, seperti List, Process, Cycle, dan lain-lain. 
[image: ]
Gambar: Berbagai Jenis Diagram
Misal, jika kita ingin membuat diagram untuk menggambarkan langkah-langkah dari suatu metode, kita bisa memilih jenis Cycle.
[image: ]
Gambar: Menambahkan Diagram Jenis Cycle
Mengisi Teks: Setelah memilih diagram, klik OK untuk menampilkan diagram tersebut. Kita dapat mengisi teks pada setiap bagian diagram, misal: Tahap 1, Tahap 2, Tahap 3, Tahap 4, dan Tahap 5. 
[image: ]
Gambar: Mengisi Teks Diagram
Jika ingin menghapus salah satu tahap, cukup klik kanan pada tahap tersebut dan pilih Delete. Diagram akan otomatis menyesuaikan jumlah bagiannya.
Kustomisasi: Di menu SmartArt Design, Kita dapat memilih warna dan gaya (style) yang diinginkan untuk mempercantik tampilan diagram.
[image: ]
Gambar: Kustomisasi Warna Diagram
Mengubah Urutan: Kita juga dapat mengubah urutan tahap dengan menggunakan fitur Move Up atau Move Down. 
Misal, jika Kita ingin menjadikan Tahap 4 sebagai yang teratas, cukup pilih tahap tersebut dan gunakan opsi Move Up.
[image: ]
Gambar: Merubah Urutan
[bookmark: _Toc182272810][bookmark: _Toc183696830]Tutorial Microsoft Word: Menggunakan Grafik
Menyisipkan Grafik: Selain SmartArt, Kita juga dapat menyisipkan grafik melalui menu Insert. 
[image: ]
Gambar: Menyisipkan Grafik
Terdapat berbagai jenis grafik yang bisa dipilih, seperti diagram batang, diagram garis, dan diagram pie. 
Misal, jika Kita ingin menggunakan diagram pie, pilih jenis grafik tersebut dan klik OK.
[image: ]
Gambar: Merubah Urutan
Mengisi Data: Setelah grafik muncul, Kita akan melihat jendela Excel untuk mengisi data. Misal, Kita dapat memasukkan data untuk tiga kategori makanan:
· Makanan 1: 10
· Makanan 2: 20
· Makanan 3: 5
[image: ]
Gambar: Mengisi Data
Setelah mengisi data, grafik akan otomatis menyesuaikan warna dan ukuran sesuai dengan data yang dimasukkan.
[image: ]
Gambar: Menyesuaikan Warna
Mengedit Data: Jika Kita perlu mengubah data, cukup klik pada grafik dan pilih Chart Design, lalu pilih Edit Data. 
Kita juga dapat mengubah gaya grafik di bagian ini dengan memilih warna dan style yang diinginkan.
Kesimpulan
Dengan menggunakan fitur SmartArt dan grafik di Microsoft Word, Kita dapat dengan mudah membuat representasi visual dari informasi dan ide-ide Kita. 
Fitur-fitur ini tidak hanya mempercantik dokumen, tetapi juga membantu dalam menyampaikan informasi dengan lebih jelas dan menarik. 
[bookmark: _Toc182273543][bookmark: _Toc183696831]Tutorial Microsoft Word: Equation dan Symbol
Pada materi terakhir ini, kita akan mempelajari tentang Equation dan Symbol di Microsoft Word. Untuk membuka fitur ini, kita bisa masuk ke menu Insert. 
[image: ]
Gambar: Menu Insert -> Equation & Symbol
Di sana, terdapat pilihan Equation dan Symbol Equation berfungsi untuk membuat formulasi rumus, terutama yang bersifat matematis. Sementara itu, Symbol digunakan untuk menambahkan simbol-simbol yang tidak tersedia pada keyboard. 
Misalnya, jika kita ingin memasukkan simbol hak cipta (Copyright), kita bisa klik Insert, lalu pilih Symbol, dan kemudian More Symbols. 
[image: ]
Gambar: Jenis-Jenis Symbol
Di sini, terdapat berbagai pilihan simbol yang bisa kita gunakan. Setelah memilih simbol hak cipta, klik Insert, dan simbol tersebut akan muncul di dokumen kita. Setelah itu, kita bisa melanjutkan mengetik teks lainnya.
[image: ]
Gambar: Penerapan Symbol Copyright
Untuk Equation, caranya hampir sama. Kita bisa memasukkannya melalui menu Insert dan memilih Equation. 
[image: ]
Gambar: Jenis-Jenis Equation
Microsoft Word menyediakan berbagai format, seperti fraction, script, dan sebagainya, termasuk akar. Sebagai contoh, jika kita ingin membuat rumus seperti alog⁡b1blog⁡abloga​alogb​1​, 
Kita bisa memulainya dengan memilih Script, lalu pilih Subscript dan Superscript. Isikan dengan aa dan log⁡blogb​. 
[image: ][image: ]
Gambar: Jenis Script -> Subscript & Superscript
Setelah itu, gunakan Fraction untuk memasukkan pecahan, dan isikan bagian atas dengan angka satu. 
[image: ][image: ]
Gambar: Menambahkan Fraction
Untuk bagian bawah, gunakan kembali Script dan isikan dengan blog⁡abloga​.
[image: ][image: ]
Gambar: Hasil Penerapan Equation
Itulah materi mengenai Equation dan Symbol di Microsoft Word. Semoga bermanfaat!
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